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Safety Information

Regulatory Compliance

The CY8CKIT-025 is intended for use as a development platform for hardware or software in a
laboratory environment. The board is an open system design, which does not include a shielded
enclosure. This may cause interference to other electrical or electronic devices in close proximity. 

In a domestic environment, this product may cause radio interference. In this case, you may be
required to take adequate prevention measures. Also, the board should not be used near any
medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-025 as shipped from the factory has been verified to meet with requirements of CE as
a Class A product.

The CY8CKIT-025 contains electrostatic discharge (ESD) sensitive
devices. Electrostatic charges readily accumulate on the human body
and any equipment, and can discharge without detection. Permanent
damage may occur on devices subjected to high-energy discharges.
Proper ESD precautions are recommended to avoid performance
degradation or loss of functionality. Store unused CY8CKIT-025 boards
in the protective shipping package.

End-of-Life/Product Recycling

This kit has an end-of-life cycle five years from the date of manufacturing
mentioned on the back of the box. Contact your nearest recycler for
discarding the kit.
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General Safety Instructions

Electrostatic Discharge Protection 

ESD can damage boards and associated components. Cypress recommends that you perform
procedures only at an ESD workstation. If one is not available, use appropriate ESD protection by
wearing an antistatic wrist strap attached to chassis ground (any unpainted metal surface) on your
board when handling parts.

Handling Boards

CY8CKIT-025 boards are sensitive to ESD. Hold the board only by its edges. After removing the
board from its box, place it on a grounded, static free surface. Use a conductive foam pad if
available. Do not slide board over any surface.
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1. Introduction

Thank you for your interest in PSoC solutions for temperature sensing. The CY8CKIT-025 PSoC®

Precision Analog Temperature Sensor Expansion Board Kit (EBK) together with the example
projects provide complete solutions demonstrating PSoC-based temperature sensing. The
CY8CKIT-025 board connects with the CY8CKIT-030 PSoC 3 Development Kit (DVK), CY8CKIT-
050 PSoC 5LP Development Kit, or the CY8CKIT-001 PSoC Development Kit. The kit supports
temperature measurement using four temperature sensors:

■ Thermocouple

■ Thermistor

■ Resistive Temperature Detector (RTD)

■ Diode

Note: The TempSense example project outputs one more temperature value read from the DS600
IC. This is used for cold junction compensation for the thermocouple and not intended as an option
for the onboard temperature sensor.

The four sensors have their own advantages and limitations. The choice of a sensor for an
application depends on the cost, accuracy required, and temperature measurement range.

Thermocouples measure temperatures in a wide range, from –250 °C to 2300 °C. However, the
voltage change is not linear and takes more CPU cycles for temperature computation.
Thermocouples require another temperature sensor, such as the thermistor, diode, or RTD, to
measure the cold junction temperature. The DS600 IC or the thermistor can be used for cold junction
compensation of the thermocouple. A thermistor, diode, or RTD cannot measure temperatures
greater than 850 °C. Thermocouples have a very good response time.

Thermistors have a highly nonlinear curve and take more CPU cycles for temperature computation.
They measure temperature in the range –100 °C to 200 °C. Thermistors have a good response time
and they are less expensive when compared to RTDs and thermocouples.

RTDs have a linear and repeatable resistance variation with temperature, making it easier to
compute temperature accurately. They measure temperature from –200 °C to 850 °C. RTDs are
expensive due to their linearity and accuracy. RTDs have a lower response time compared to a
thermistor or thermocouple.

Diodes are the cheapest sensors for temperature measurement. They measure temperature in the
range –50 °C to 150 °C. Accurate temperature measurement is difficult with a diode. Table 1-1
shows a comparison among the four sensors. 
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Note: The temperature sensor comparison chart does not include values for DS600 IC because it is
used for cold junction compensation for the thermocouple; it is not intended for use as an onboard
temperature sensor.

This kit includes three example projects, divided into project areas based on end applications. Each
project area contains examples for the CY8CKIT-030, CY8CKIT-050, and CY8CKIT-001
development kits. The CY8CKIT-030 DVK contains a PSoC 3 (8051 core) and the CY8CKIT-050
DVK contains a PSoC 5LP (ARM Cortex-M3); both support high-performance analog applications.

The CY8CKIT-001 DVK can be used to develop solutions for PSoC 1 (M8C proprietary core),
PSoC 3, or PSoC 5LP (ARM Cortex 3). The included example projects support PSoC 3 (8051) and
PSoC 5LP (ARM Cortex-M3). 

The Tempsense example project provided with the kit supports most temperature sensing
applications. It provides a high-performance temperature sensing example by using the ADC in 20-
bit mode and implementing a high-precision linearization algorithm. It includes a resistance
temperature detector (RTD), thermocouple, thermistor, two temperature diodes, and an IC
temperature sensor. You can evaluate and compare sensor performance. Complete interface and
output signal correction solutions can be developed for each type of temperature sensor. With the
20-bit ADC of the PSoC, it is possible to obtain a 0.1-°C resolution easily with all four sensors. The
accuracy varies in each case depending on the method of measurement and the sensor used. See
the Hardware chapter on page 24 for details.

The Sequenced ADC example project includes three temperatures (RTD, temperature diode, and IC
temperature sensor) as well as millivolt and voltage inputs. This project can be used for sensing
applications that require temperature measurement (such as RTD) as well as other types of voltage
output sensors. It can also be used for system monitoring applications requiring temperature (usually

Table 1-1.  Temperature Sensor Comparison

Parameter RTD Thermocouple Thermistor Diode 

Temperature range 
(°C)

–200 to +850 –250 to +2350 –100 to +300 –50 to +150

Sensitivity at 25 °C 0.387 Ω/°C 40 μV/°C (K-type) 416 Ω/°C 250 μV /°C

Accuracy High Medium to High Medium Low

Linearity Good Fair Poor Good

Typical cost (US $) $3–$80 $3–$15 $0.2–$10 <$0.2

Typical distance of 
sensing

Surface mount for 
onboard temperature. 
3- and 4-wire up to a 
few hundred meters

<100 meters
Surface mount for 
onboard temperature. 
Leaded for <1 meter

Onboard temper-
ature

Resource require-
ment

Excitation current, 
amplifier, ADC, refer-
ence resistor

Amplifier, ADC, volt-
age reference, and 
another temperature 
sensor for cold junc-
tion

Excitation current, 
ADC, reference resis-
tor

Excitation cur-
rent, amplifier, 
ADC

Response time Slow Fast Fast Slow

Computational 
complexity (best 
possible accuracy)

High Very high Very high Medium

Cypress applica-
tion note

AN70698 AN75511 AN66477 AN60590
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temperature diode or IC temperature sensor) and voltage rail measurement. The sequenced ADC
example project uses the ADC in 16-bit mode and provides a higher throughput. In this project, the
ADC readings are automatically repeated at consistent intervals, which allow filtering of ADC
readings to remove specific frequencies of interest, such as a 50- and 60-Hz hum.

The Thermal Management System example project supports fan control applications. Add the
CY8CKIT-036 EBK (with two four-wire fans) to the CY8CKIT-025 EBK and a development kit to
support complete temperature-based fan control solutions. For more details on CY8CKIT-036 PSoC
Thermal Management EBK, see the Cypress website.

1.1 Kit Contents

The CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK includes: 

■ CY8CKIT-025 PSoC Precision Analog Temperature Sensor Board

■ Two CY8CKIT-012 prototype boards

■ Omega thermocouple K-type 5srtc-gg-20-36

■ Two 2N3904 NPN transistors

■ Two prototype headers for CY8CKIT-012 prototype board

■ Quick start guide

■ Resource CD

■ Wires

■ Mini Philips cross screw driver (black)
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Figure 1-1.  CY8CKIT-025 Kit Contents
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1.2 PSoC Creator™

Cypress's PSoC Creator software is a state-of-the-art, easy-to-use integrated development
environment (IDE) that introduces a hardware and software design environment based on classic
schematic entry and revolutionary embedded design methodology.

With PSoC Creator, you can:

■ Automatically place and route select components and integrate simple glue logic normally 
located in discrete muxes.

■ Trade off hardware and software design considerations, allowing you to focus on what matters 
and getting to market faster.

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler tool
chains, RTOS solutions, and production programmers to support both PSoC 3 and PSoC 5LP
devices.

1.3 Getting Started

Follow the steps in the Software Installation chapter on page 15 to install the kit. See the Kit
Operation chapter on page 18 and Hardware chapter on page 24 to understand the kit operation and
hardware. The Example Projects chapter on page 30 explains the details of the firmware and
provides steps to run the projects.

1.4 Additional Learning Resources

Visit www.cypress.com/go/psoc3 for additional learning resources in the form of datasheets,
technical reference manual, and application notes. 

1.4.1 Beginner Resources

AN54181 - PSoC 3 - Getting Started with a PSoC 3 Design Project

PSoC Creator Training

1.4.2 Engineers Looking for More

AN54460 - PSoC® 3, PSoC 4, and PSoC 5LP Interrupts

AN52705 - PSoC® 3 and PSoC 5LP - Getting Started with DMA

AN52701 - PSoC® 3 and PSoC 5LP - Getting Started with CAN (Controller Area Network)

AN54439 - PSoC® 3 and PSoC 5LP External Crystal Oscillators

AN52927 - PSoC® 3 and PSoC 5LP: Segment LCD Direct Drive

Cypress continually strives to provide the best support. Click here to view a growing list of
application notes for PSoC 3 and PSoC 5LP.

1.4.3 Learn from Peers

Cypress Developer Community Forums
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1.4.4 More Code Examples

PSoC Creator provides several example projects that make code development fast and easy. To
access these example projects, click Find Example Project… under the Example and Kits section
in the Start Page of PSoC Creator or navigate to File > Open > Example Project….

Figure 1-2.  Find Example Project

The Find Example Project section has various filters that help you locate the most relevant project.
PSoC Creator provides several starter designs. These designs highlight features that are unique to
PSoC devices. They allow you to create a design with various components, instead of creating a
new empty design; code is also provided. To use a starter design for your project, navigate to File >

New > Project and select the design required.
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Figure 1-3.  New Project

The starter designs and the example project contain a PDF within the project that explains the fea-
tures of the project and its configuration.

Figure 1-4.  Project PDF Location

Note: The example projects and starter designs are designed for CY8CKIT-001 PSoC Development
Kit. However, these projects can be converted for use with CY8CKIT-030 PSoC 3 Development Kit
or CY8CKIT-050 PSoC 5LP Development Kit by following the procedure in the knowledge base arti-
cle Migrating CY8CKIT-001 DVK project to CY8CKIT 030/ 050.

Apart from the example projects and starter designs that are available within PSoC Creator, Cypress
continuously strives to provide the best support. Click here to view a growing list of application notes
for PSoC 3, PSoC 4, and PSoC 5LP.

1.4.5 Technical Support

For assistance, go to www.cypress.com/go/support or contact our customer support at 
+1(800) 541-4736 Ext. 2 (in the USA), or +1 (408) 943-2600 Ext. 2 (International).
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1.5 Document Conventions 

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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2. Software Installation

The kit CD/DVD contains the PSoC Precision Analog EBK-related software. The installer in the CD/
DVD checks if the prerequisites – PSoC Creator, PSoC Programmer, Windows Installer,
Windows .NET, and Keil C51 compiler, are installed in your PC. If these applications are not
installed, then it installs them before installing the kit. If the Acrobat Reader application is not
installed in your PC, then the installer provides the link to install the same; this does not prevent kit
installation. Note that Adobe Reader is required to view the kit documents. The installer also installs
the example projects, user guide, quick start guide, and other kit-related documents as part of kit
installation.

The installation steps are as follows:

1. Insert the kit CD/DVD into the CD/DVD drive of your computer. The CD/DVD is designed to auto-
matically open an installation dialog (see Figure 2-2). Note: If auto-run does not execute, double-
click cyautorun.exe in the root directory of the CD/DVD.

Figure 2-1.  CD/DVD Root Directory

2. The CD/DVD installation dialog prompts you to open this file or begin installing the development 
environment software. Click the Install PSoC Precision Analog EBK button to begin installation.
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Software Installation

Figure 2-2.  PSoC Precision Analog EBK Window

3. Choose the Typical installation type in the Product Installation Overview window.

PSoC Creator uses the DP8051 Keil 9.51 compiler to build PSoC 3 applications. This compiler is
included on the CD/DVD; the installer will prompt you to install the compiler if it is not detected. 

Note: The Keil compiler is distributed with a free license. You must activate this license within 30
days of installation. When the Cypress software installation is complete and you run PSoC Creator,
activate the compiler license from Help > Register > Keil.

Note: If there is a problem with Keil registration, rename the *_tools.ini file in
<Install_Directory>\PSoC Creator\<version>\PSoC Creator\import\keil\pk51\

<version> to "tools.ini" for the Keil registration to be successful.

After the installation is complete, the following are installed in your computer:

■ PSoC Creator 3.3 CP3 or later

■ PSoC Programmer 3.24.2 or later 

■ Kit documents:

❐ Quick Start Guide

❐ User Guide

❐ Temperature Sensor Datasheets

■ Firmware

❐ Example Projects

■ Hardware

❐ Schematic

❐ Layout

❐ Bill of Materials (BOM)
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If you have PSoC Creator and PSoC Programmer already installed in your computer, the installer
will install only the kit-related files in <Install_Directory>\PSoC Precision Analog EBK\
<version>, as shown in Figure 2-3.

Figure 2-3.  Installed Files

After installation, launch the example projects associated with the kit from the PSoC Creator Start
Page, as shown in Figure 2-4.

Figure 2-4.  PSoC Creator Start Page
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3. Kit Operation

3.1 Kit Overview

Figure 3-1 shows the CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK. The circuits
associated with each sensor are boxed and labeled in the figure. The kit has an RTD, a thermistor,
and a DS600 IC sensor onboard and provides interface slots to plug in your thermocouple, diode,
thermistor, or external RTD. The kit includes two diodes and a K-type thermocouple.

Figure 3-1.  CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK

3.2 Kit Connections

The CY8CKIT-025 EBK connects to a development kit (DVK) using a 2×20 pin connector. You can
use the CY8CKIT-030 PSoC 3 DVK, CY8CKIT-050 PSoC 5LP DVK, or CY8CKIT-001 PSoC DVK.
The CY8CKIT-025 EBK can be connected to port E of the CY8CKIT-030 PSoC 3 DVK (see
Figure 3-2) or port E of the CY8CKIT-050 PSoC 5LP DVK (see Figure 3-3), or port A of the
CY8CKIT-001 PSoC DVK (see Figure 3-4).

2X20 Pin Connector 

for Development Kit  

Interface

RTD Section
Thermistor Section

Diode 

Section

Thermocouple  Section
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Figure 3-2.  Connect 2×20 Pin Connector to Port E of CY8CKIT-030 PSoC 3 DVK
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Figure 3-3.  Connect 2×20 Pin Connector to Port E of CY8CKIT-050 PSoC 5LP DVK

Figure 3-4.  Connect 2×20 Pin Connector to Port A of CY8CKIT-001 PSoC DVK
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WARNING: Static discharges from the human body can easily reach very high voltages in the order
of kV. Such voltages can damage the PSoC device on the development kit. Ensure that you dis-
charge any static before touching the hardware. Follow these steps to avoid any unwanted behavior
on the board:

1. Power off the kit before making any connections

2. Connect the CY8CKIT-025 EBK to the development kit being used

3. Power on the development kit

3.3 Temperature Sensors

The PSoC Precision Analog Temperature Sensor EBK supports the following temperature sensors:

■ Thermocouple

■ Thermistor

■ Resistive Temperature Detector (RTD)

■ Diode

■ DS600 IC

3.3.1 Thermocouple

The board has a K-type thermocouple socket, PCC-SMP-K-5. The K-type Omega thermocouple,
5SRTC-GG-K-20-36, is shipped with the kit. It complies with the ASTM special limits of error toler-
ance standard. IC DS600 is provided on the board for cold junction compensation. The thermistor on
the board can also be used for cold junction compensation. Because the onboard thermistor is not
calibrated, the IC (DS600) is provided for cold junction compensation. AN75511 - Temperature Mea-
surement with Thermocouples provides an example project that demonstrates how to use the therm-
istor for cold junction compensation. For more details about the thermocouple 5SRTC-GG-K-20-36
and IC DS600, see their datasheets in the following location: 
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet.

While connecting the thermocouple to the connector, make sure the markings in the thermocouple
match those of the connector.

Figure 3-5.  Thermocouple

3.3.2 Thermistor

The board has a NCP18XH103F03RB (NTC) thermistor. It has a 1 percent tolerance (10 k ± 1%) at
25 °C. For more details about the sensor, see its datasheet in the following location: 
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet

You can also plug an external thermistor in terminal J7. The choice between using the internal and
external thermistor is made using jumper J5. The jumper is inserted on header position 1–2 for using
an external thermistor and on header position 2–3 for using the internal (onboard) thermistor. The
silk indicates the jumper positions for internal and external thermistors.
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Figure 3-6.  Thermistor

3.3.3 RTD

Platinum RTD PTS080501B100RP100, which is a class B PT-100 RTD, is used on the board. See
the RTD datasheet in the following location for more details: 
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet. 

You can connect any external four-wire RTD. Follow these instructions to use the internal and
external RTDs.

■ External RTD: Connect the external RTD to terminal blocks J8 and J9. The silk helps in the con-
nection. Remove jumper J6.

■ Internal (onboard) RTD: Place jumper J6. On jumpers J8 and J9, short 1–2. Figure 3-7 shows the 
connections for an internal RTD.

Figure 3-7.  RTD

3.3.4 Diode

Terminal block J4 provides the option to connect up to two diode connected transistors. The diodes
are connected anti-parallel (see Figure 4-4 on page 29) to each other so that two temperatures are
measured with just four pins – two pins to pass current and two pins to measure VBE.

J4 (1-4) is used to connect transistor 1. Connect the collector, base, and emitter to screws J4 1, 2,
and 3, respectively. Use a small wire to short J4, 3–4. This is to support four-wire measurement so
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that the series resistance error can be avoided. See the Diode section on page 28 for details. This
wire also shorts the base and collector of transistor 2. 

If you are installing only transistor 1, make sure you also have a wire between J4, 7–8 so that the
base and collector of transistor 1 are shorted. Alternatively, you can short the base and collector
directly on the transistor, as shown in Figure 3-8.

J4 (4–8) is used to connect transistor 2. Connect the collector, base, and emitter to screws J4 5, 6,
and 7, respectively. Use a small wire to short J4, 7–8. This is to support four-wire measurement so
that the series resistance error can be avoided. See the Diode section on page 28 for details. This
wire also shorts the base and collector of transistor 1.

If you are installing only transistor 2, make sure you also have a wire between J4, 3–4 so that the
base and collector of transistor 2 are shorted. Alternatively, you can short the base and collector
directly on the transistor, as shown in Figure 3-8.

The 2N3904 transistor is shipped with the kit. See the datasheet in the following location for details: 
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet.

Figure 3-8.  Diode

3.4 Prototype Boards

The kit includes two CY8CKIT-012 prototype boards. The prototype boards plugs into any port of
DVKs, CY8CKIT-001, CY8CKIT-030, and CY8CKIT-050 and they can be used for prototyping your
custom circuit built around PSoC. 
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4.1 System Block Diagram and Theory of System Operation

The schematic of the CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK is shown in
the Appendix on page 83. The circuits associated with each temperature sensor are boxed
individually. This section gives a description of each circuit and the temperature equations involved
in each method. 

4.2 Thermocouple

Cypress application note AN75511 - PSoC 3/PSoC 5LP Temperature Measurement with a
Thermocouple explains the theory behind the thermocouple terminology; see the application note to
understand thermocouple temperature measurement. This section assumes that you have prior
knowledge of thermocouple terminology. 

A thermocouple gives an output voltage that is directly related to the temperature difference between
two metallic junctions. The output voltage is not linearly related to temperature. The output voltage
versus temperature curve can be considered piece-wise linear with different slopes in different
temperature ranges. The relation between hot junction voltage and cold junction voltage is given by
the following equation.

Equation 1

where the value of K depends on the temperature range. V1 is the voltage across the hot junction
and V2 is the cold junction compensation (CJC) voltage (see AN75511 for details on cold junction
compensation). T is the hot junction temperature.

Figure 4-1 shows the circuit used for thermocouple temperature measurement. A three-channel
ADC is used. 

■ Channel 0 is used for thermocouple voltage measurement

■ Channel 1 is used for cold junction compensation

■ Channel 2 is used for offset cancellation

V2KTV1 
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Figure 4-1.  Thermocouple Circuit Diagram

The cold junction compensation IC measures the cold junction temperature and outputs a voltage
proportional to the temperature. The ADC measures the cold junction output voltage to calculate the
cold junction temperature. This temperature is used to calculate the cold junction compensation, V2.

V1 is measured in the first ADC channel. The temperature can be calculated using equation 1 if V1,
V2, and K are known. 

The lower potential lead of the thermocouple connector is biased at a potential above ground so that
negative temperatures up to –270 °C can be measured after accommodating for small negative
device offset. PSoC Creator provides a thermocouple component that supports all thermocouple
types (B, E, J, K, N, R, S, and T) and simplifies voltage-to-temperature conversion and vice versa.

4.3 Thermistor

Application note AN66477 - PSoC 3 and PSoC 5LP Temperature Measurement with Thermistor
explains the thermistor theory and temperature measurement with thermistor. This section assumes
that you are aware of thermistor fundamentals and terminology. 

The thermistor resistance changes with temperature in a nonlinear fashion. Thermistor
manufacturers provide the thermistor temperature versus resistance table. The Steinhart-Hart
equation (equation 2) characterizes thermistor resistance change with temperature to a good
accuracy and can be used to find temperature from thermistor resistance.

Equation 2

where,

- A, B, and C are the Steinhart-Hart coefficients

- R is the resistance at temperature T expressed in Kelvin

Figure 4-2 shows the circuit diagram used for the measurement. An excitation voltage is applied
across a series combination of thermistor and precision reference resistor, and the voltages across
thermistor and reference resistor are measured.

3.3 V

ADC

Thermocouple
 Connector

330 k

1.5 k
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